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Typographic Conventions

Type Style

Description

Icons

Example Text

Words or characters quoted
from the screen. These
include field names, screen
titles, pushbuttons labels,
menu names, menu paths,
and menu options.

Cross-references to other
documentation

Icon Description

A\ Caution

0 Note or Important

& Example

(1] Recommendation or Tip

Example text

Emphasized words or
phrases in body text, graphic
titles, and table titles

Example text

File and directory names and
their paths, messages,
names of variables and
parameters, source text, and
names of installation,
upgrade and database tools.

Example text

User entry texts. These are
words or characters that you
enter in the system exactly as
they appear in the
documentation.

<Example
text>

Variable user entry. Angle
brackets indicate that you
replace these words and
characters with appropriate
entries to make entries in the
system.

EXAMPLE TEXT

Keys on the keyboard, for
example, F2 or ENTER.
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1. Prerequisites

This guide is written based on the following software versions. The steps for other software versions are mostly the
same or similar, and the differences are pointed out wherever necessary.

e SAP HANA Cloud

e SAP Analytics Cloud

e Microsoft SQL Server 2017

o S/AHANA on premise 1809

e SAP Data Provisioning Agent 2.5.3 (SP05)
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2. Introduction
2.1 Goal

This document will help you run a real-time business with live analytics. Using SAP HANA Cloud as a data gateway,
the live analytics capabilities of SAP Analytics Cloud will be expanded across heterogeneous data sources and SAP
Analytics Cloud will be the central analytics solution for your corporation.

2.2 Background
2.2.1 Live Data Connectivity in SAP Analytics Cloud

SAP Analytics Cloud provides live data connections to on-premise and cloud systems. Data is “live”, meaning that when
a user opens a story in SAP Analytics Cloud, up-to-data data in the source system are retrieved immediately.

In SAP Analytics Cloud, you can create models from data sources in on-premise or cloud systems, build stories based
on those models, and perform online analysis without data replication. The Live data connectivity allows SAP Analytics
Cloud to be used in scenarios where data cannot be moved into the cloud for security or privacy reasons, or your data
already exists on a different cloud system.
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Using a live connection, SAP Analytics Cloud provides the business logic and builds the queries required to see your
data in your browser. Your browser in turn sends those queries through a direct live connection to the on-premise data
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source. The results of those queries are returned to your browser, where visualizations are rendered. If your query
was a list of profits per customer, for example, none of that information would return to or be stored in SAP Analytics
Cloud. SAP Analytics Cloud stores queries for building the stories, measure names, columns names, filter values, and
so on. Basically, the metadata lets SAP Analytics Cloud rebuild the query. But none of the payload data, not even the
query results or part of the results, such as totals, are saved to SAP Analytics Cloud. Metadata is transferred to your
browser and encrypted in memory.

Currently, SAP Analytics Cloud can connect to six types of live data sources: SAP HANA, SAP BW, SAP S/4AHANA,
SAP Universe, SAP BPC Embedded, and SAP Data Warehouse Cloud.

2.2.2 The Challenge and the Solution

The Live Data Connection is a preferred connection type for SAC to connect to remote sources, but it can only connect
to six different data sources, specifically, six SAP systems. SAP Analytics Cloud doesn’t provide live data connections
to many other SAP solutions. Neither does SAC provide live data connections to non-SAP systems, such as Microsoft
SQL Server, Oracle, MySQL, etc. These data sources are widely used by customers today. Moreover, this is not only
about non-SAP systems, but also about those SAP systems such as SAP ECC 6.0 that cannot be connected live today.
Although SAC provides acquired data connection to some other SAP solutions and non-SAP data sources, it has
limitations on data volume of each data load, maintenance of delta load, replication and synchronization of authorization
models. It would make SAP Analytics Cloud a broader adopted analytic application if it can provide live analytics to more
SAP and non-SAP data sources.

To solve this challenge, SAP HANA Cloud can be used as a single gateway to connect to both on-premise and cloud
data sources as shown in the following figure. With the data virtualization in SAP HANA Cloud, the analytical data won’t
be replicated from the remote source to SAP HANA Cloud or from SAP HANA Cloud to SAP Analytics Cloud. Hence,
the customer can make decision for their organization based on the business insight in real-time. Moreover, this solution
expands the Live Connections from SAP data to Non-SAP data, which makes SAP Analytics Cloud become an
enterprise-wide analytics solution.

:I SAP AnalyticsCIoEI ] o = Cloud-based
| | | Applications .
7 = On-Premises
SAP HANA Cloud
DATA DELIVERY
(Interfaces)
= Fabric Virtual Table
TRANSFORMATION MODELING » Extension of SAP HANA Virtual Table

& £ SAP HANA Cloud + Enhanced Database SQL-Optimization

» Online switch federation/caching/replication

» Transparent to the consumers

FABRIC
VIRTUAL
TABLE

VIRTUAL
ACCESS

trusTeD (@)

SAP Cloud External Cloud On-premise
Sources Sources Sources

Remote Sources

= Structured
= Semi-Structured
= Unstructured
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2.2.3 Connecting SAP HANA Cloud to Remote Data Sources

SAP HANA Cloud provides a single place to access, store, and process all enterprise data in real time. It is a cloud-
native platform that reduces the complexity of multi-cloud or hybrid system landscapes. SAP HANA Cloud provides all
of the advanced SAP HANA technologies for multi-model data processing in-memory or on disk. You can benefit from
cloud qualities such as automatic software updates, elasticity, and low total cost of ownership by using SAP HANA
Cloud either as a stand-alone solution or as an extension to your existing on-premise environment.

The SAP HANA Cloud provides simplified data access to connect all your information without the need to have all data
loaded into a single storage solution. This capability provides operational and cost benefits and supports the
development and deployment of next-generation analytical applications requiring the ability to access, synthesize, and
integrate data from multiple systems in real time. In SAP HANA Cloud, you can create virtual objects using either SAP
HANA Smart Data Access (SDA) or SAP HANA Smart Data Integration (SDI).

2.2.3.1 Virtualizing Data Using SDA

In SAP HANA Cloud, you create virtual tables, which point to remote tables in different data sources, and then write
SQL queries to use these virtual tables. The SAP HANA query processor optimizes these queries by executing the
relevant part of the query in the target database, returning the results of the query to SAP HANA, and then completing
the operation. Physical data movement is not supported by SAP HANA Smart Data Access. Smart Data Access provides
the ability to access and integrate data from multiple systems in real time regardless of where the data is located or
what systems are generating the data. Thus, SDA enables SAP HANA Cloud to access heterogeneous sources in real-
time.

The following figure shows the SDA supported databases as remote sources for SAP HANA Cloud. For more
information, please see SAP HANA Smart Data Access Supported Remote Sources.

i EYHANA] W

.l||l||
!

@ HANA ‘ Amazon Athena

- Q Google =

BigQuery

2.2.3.2 Virtualizing Data Using SDI

Virtualizing data is also supported by SAP HANA Smart Data Integration (SDI). SDI uses SDA as a foundation and
extends the capabilities of SDA. SAP HANA SDI also supports virtually accessing a variety of remote sources in real
time using pre-built and custom adapters. The SAP HANA Data Provisioning Agent is required for connections with SDI.
Virtual tables can be created for remote sources supported by SDI in the same way as for SDA.

SDI supports more remote sources and more versions of remote sources than SDA. The following figure shows some
of the SDI supported remote sources for SAP HANA Cloud. For more information, please see SAP HANA SDI and all
its patches Product Availability Matrix (PAM).
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2.2.4 Advantages of Using SAP HANA Cloud as a Data Gateway

When using SAP HANA Cloud as a single gateway to all your data, it offers the following advantages:

e Manage data from both SAP and non-SAP landscape
e Gain real-time insight

2.2.4.1 Central Solution to All Your Data

SAP HANA Cloud helps organizations manage and access large volumes of data coming from multiple sources via
data virtualization, offering simplicity and scalability. With data virtualization, SAP Analytics Cloud can live connect to
heterogenous data sources via SAP HANA Cloud. In other words, SAP HANA Cloud expands the Live Analytics
capabilities of SAC from SAP-centric usage to enterprise-wide analytics tool. Therefore, SAP Analytics Cloud
becomes a central analytics solution to all your enterprise data.

2.2.4.2 Live Analytics

In the world of analytics, real-time reporting has been sought after for the last decade. With data virtualization, SAP
Analytics Cloud performs advanced analytics on live transactional data, structured, in real-time and without data
duplication. SAP HANA'’s in-memory analytics is the game changer that makes this possible, delivering rapid access to
visually rich data that can be interactively explored and quickly analyzed. SAP HANA Cloud brings the simplicity and
speed of SAP HANA to the cloud and stimulates the performance considering the whole thing is completed under the
seamless platform. Hence, the business users can leverage SAP HANA Cloud to explore the accountable insights and
make decisions with confidence in SAP Analytics Cloud.

2.2.4.3 SAP HANA Benefits

SAP HANA Cloud is not just a data gateway to remote sources. In SAP HANA Cloud, hierarchies can be added on flat
data structure in source tables. This additional value is very important because it enables SAC to perform drill down
analysis. SAP HANA Cloud supports both parent-child hierarchy and level-based hierarchy, and both can be consumed
by SAC. Apart from exposing data from various remote sources in the form of virtual tables, data virtualization allows to
combine these data with data resides in the SAP HANA physical tables. The feasibility to apply HANA planning,
predictive as well as text search algorithm with the combined dataset provides an outstanding benefit to the customers
and business.
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3. Setup Connection to Microsoft SQL Server

In this section, we will take Microsoft SQL Server as an example remote database and setup SAC live data connection
to Microsoft SQL Server using SAP HANA SDI. Firstly, we need to setup SQL Server JDBC driver in Data
Provisioning Agent to ensure that SAP HANA Cloud can access Microsoft SQL Server through JDBC protocol. Next,
we create virtual tables that point to the tables in SQL Server, and then use the virtual tables to create calculation
views, which can be consumed by SAC. Lastly, SAC establishes a live data connection to SAP HANA and eventually
visualized the data in Microsoft SQL Server. The system landscape is setup as below.

Live Connection MSSQLLogReaderAdapterl =~ Remote Object

= (Table/Procedure

(JDBC)

L1

Microsoft SQL Server

SAP Analytics Cloud SAP HANA Cloud

To test the Live Analytics to SQL Server, we created a sample database in SQL Server. The sample database
contains three tables: CountryCode, Sales, and Region under the one schema. The following figure illustrates the
sample database diagram. The following tables are not provided in this documentation. You may use any similar
tables in your database to create a calculation view in this exercise.

[Total Revenue]
[Total Cost]
[Total Profit]

CountryCode Sales Region
CountryCode RegionID [OO=——=C%| ¢ [Region ID]
Country kD Country Region
NATIO [Item Type]

LANDX50 [Sales Channel]

NATIOS50 [Order Priority]
[Order Date]
[Order ID]
[Ship Date]
[Units Sold]
[Unit Price]
[Unit Cost]
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3.1 Install and Configure SAP Data Provisioning Agent

Explanation Screenshot
1. Data Provisioning Agent | F s ST HANA_DP_AGENT 20 WIN_X86 64
Planning and Preparation. Home  Share  View | Manage
a. Supported Platforms and © - 1~‘ « SDAAgent » HANA_DP_AGENT_20_WIN_X86_64 v c,‘ [ Search HA
System Requirements X Eavorites Nare * Date modified Type Size
b_ Soﬁware DOWnIoad Bl Desktop . instruntime File folder
& Downloads packages File folder
2' Download SAP HANA SDI 20 =] Recent places hdbchentreg Application 39KB
and extract the software to an 153 hdbinst 7134PM  Application 39KB
em t dlreCtO 1% This PC [ hbsetup 71:34PM  Application 39KB
pty ry 4 Desktop hdbuninst Application 0 K8
~| Documents (% msver100.dil Application extens... 810KB
& Downloads
Jf Music
= Pictures
B Videos
&, Local Disk (C:)
3. Navigate to the directory where ¥ SAP HANA Data Provisioning Agent Installation 2.5.3.1.0
you unpacked the software and
execute hdbsetup.exe SAP HANA
4. Assign a folder name for the Data Provisioning Agent
new SAP HANA DATA
Provisioning Agent and click i q 5 . ” e o
Next
Define dataprovagent Define Installation Review & Confirm Install Software Finish
Properties Properties
Choose an installation to update, or choose a path for a new installation
() Update SAP HANA Data Provisioning Agent Installation Details
Drusrisap\dataprovagent_hc To be installed
Version® 25310
® fnstail new SEF HERE Bata Provisioning Agent: Mode:  G4bit
Chusr\sap\dataprovagent ||:|
Installation path: Cusnsap\dataprovagent
< Previous Mext » ‘ | Cancel
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5. Fill up all the mandatory fields
and click Next

SAP HANA Data Provisioning Agent Installation

SAP HANA
Data Provisioning Agent

2 3] 7] fo—u

Define Installation Review & Confirm Install Software Finish

Properties

Define dataprovagent
Properties

Specify the Installation Properties

Agent Unique Name (used as suffix for service name):* | HANACIoud

Domain\Username for Agent service (user must exist):* |

[seeeeeee

Password for Agent service user:*

Password for Agent service user Confirmation:*

< Previous | | Next > l Cancel

6. Click Install and Finish the
installation

SAP HANA
Data Provisioning Agent

1

1 7] 3 K g8 —

Define Installation Review & Confirm Install Software Finish

Properties

Define dataprovagent
Properties

@ IMPORTANT NOTE: You are installing Data Provisioning Agent with default settings. The default settings use insecure channel to
communicate with HANA server. For secure communication, SSL settings must be configured via the Data Provisioning Agent

Configuration tool after the installation is complete. Please see SAP HANA Smart Data Integration Installation and Configuration Guide

for details on configuring SSL between the Agent and HANA server.

Summary

SAP HANA Data Provisioning Agent Installation

- Agent Unique Name (used as suffix for service name): HANACloud
Domain\Username for Agent service (user must exist): ©
[+ Software Components (1289.96 MB)

< Previous | | Install | | Cancel
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7. Before registering the adapter
with the SAP HANA system,
ensure you have downloaded
and installed the correct JDBC
libraries. See the SAP HANA
smart data integration Product
Availability Matrix (PAM) for
details.

Download Microsoft JDBC Driver
for SQL Server

03/02/2021 - 2 minutes to read - '§ " Jo= ’J"' ] . +8

The Microsoft JDBC Driver for SQL Server is a Type 4 JDBC driver that provides database
connectivity through the standard JDBC application program interfaces (APIs) available on
the Java platform. The driver downloads are available to all users at no extra charge. They

provide access to SQL Server from any Java application, application server, or Java-enabled
applet.

Download

Version 9.2 is the latest general availability (GA) version. It supports Java 8, 11, and 15. If you
need to use an older Java runtime, see the J ) i rt matrix to see
if there's a supported driver version you can use. We're continually improving Java
connectivity support. As such we highly recommend that you work with the latest version of
Microsoft JDBC driver.

Download >ft JDBC Driv

Download V ft JDBC Driver

8. Unzip the downloaded package
and place the files in the
<DPAgent_root>/lib folder

Note: <DPAgent _root> is the
directory where the DP agent was
installed. By default, on Windows,
this is C:\usr\sap\dataprovagent,
and on Linux it is
/usr/sap/dataprovagent.

File Home Share View o

« v 4 || | « Application (D:) » usr » sap > dataprovagent_hc » lib »

v E.l| | Search lib Vol ‘

il Name Date modified Type Size

3 Quick access
B Desktap
@ Downloads =

hive 3/30/2021 1237 AM  File folder

E mssgl-jdbc-9.2.0,jre8 jar 1/28/2021 1:59 AM WinRAR archive

1,297 KB

| Documents

&=| Pictures
dataprovagent_dwc
profile
SAP MMC Snapln
System32

[ This PC

B Deskton >
2items  State: @& Shared

9. Open an Administrator prompt
on the Windows where the DP
agent is installed

ws [

osoft

admin:

10. Start the Data Provisioning
Agent: You must start the
agent, if it has not been started
already: Select option 2. Start
or Stop Agent, and then option
1. Start Agent.

Select b. Back to go back to
the main menu.

T parameter

Initializing DPAgent Configuration Tool
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<DPAgent root>\bin\agentcl
i.bat --configAgent

11. Select option 6. SAP HANA
Connection

onment wi
HTTP

12. Select option 1. Connect to
SAP HANA Cloud via JDBC

Specify the hostname, port, and keep default or skip an optional setting.
Agent Admin HANA User I kipped, that means it is required.
credentials for the SAP HANA Enter Use encrypted JDBC connection[true]: Valid options: true|false

server as prom pted . )
Host Name[ .hanacloud.d

Select b. Back to go back to Port Number[443]:
the main menu. i Lo
Agent Admin HANA User[DBADMIN]:
Agent Admin HANA User Password:
Agent Admin HANA User Password: (confirm)
Use Proxy Server[true]: Valid options: true|false

Server HTTP? (Enter true for HTTP or false for SOCKS)[true]: Va
Proxy Host[proxy]:
Proxy Port[8080]:

Enter Use Proxy Authentication[false]: Valid options: true

Enter HANA User Name for Agent Messaging[XSADMIN]:

Enter HANA User Password for Agent Messaging: (***** )

_onnecting to SAP HANA server via JDBC...
\gent configuration is connected to SAP HANA server via JDBC.
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Select option 7. Agent
Registration t Configuration Tool

L P

[Wg I Y

]

=]

13. Select option 1. Register
Agent

Specify the agent connection
information as prompted.

Select b. Back to go back to Enter Agent Name[dpagent_ wdflbmt2652]:
the main menu.
Enter Agent Host Name[wdflbmt2652]:

Registering agent ‘dpagent_wdflbmt2652' with SAP HANA.
Agent 'dpagent_wdflbmt2652" successfully registered.

14. Select option 8. Adapter \dapter Regicstration
Registration

15. Select option 2. Register
Adapter

16. Enter adapter name:
MssqlLogReaderAdapter

Note: The adapter name must
match the name displayed by the
option 1. Display Adapters.
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3.2 Add SQL Server as a Remote Source

Next, we will add the SQL Server as a remote source in SAP HANA Database Explorer. The following privileges are
required to manage remote sources and virtual tables:

e System privileges: CREATE REMOTE SOURCE
e Object privilege: CREATE VIRTUAL TABLE on remote source SQLServerl7

Explanation Screenshot
17. Logon to SAP HANA Cloud & Applications @ SAP Internal - P&T CEE (CPEA) ~ | & P&T GlobalPROD ~ | [ PROD -
instance and open the SAP o
HANA Cockpit. W Services v SAP HANA Cloud
Service Marketplace
Instances Searc =
&3 SAP HANA Cloud
@& Routes SAP HANA Database Instances
2B security Groups hanacloud
=1 Events m
Memon CPU Storage
& Members 30 GB 2 vCPUs 120 GB
Actions ~

Copy SQL Endpoint

Copy Instance ID

5

Open In SAP HANA Cloud Central

Open In SAP HANA Cockpit

I

Open In SAP HANA Database Explorer

=

Open SQL Console

5
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18. You are currently logging in as SAP  Database Overview v € ¢ © ® 4 8

DBADMIN. You can switch to a
SQL Console _Z

technical user by clicking

. . All v
Choose Authentication
Database Status Database User.
O Running DBADMIN
Host Instance:
807ee9f4-54a9-4b94-9faf-be2540e76fed.hana.prod-eul0.hanacloud.ondemand.com 0
Sea Q
Services Alerts
O Running All services are running No current alerts
Manage Services Alert Definitions
Memory Usage CPU Usage

Used Memory Resident Memory

19. Enter Username and
Passowrd
20. Click OK

Credentials

There are currently stored database logon credentials for hanacloud. What
would you like to do?

| ®) Log on with a different database user

Username:

‘ ANALYTICSADMIN ‘

Passwaord:

I T YTy ‘

Delete the stored credentials for this database

OK Cancel
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21. Open SQL Console SAP  Database Overview v e C ©» ® o8

Al v
Database Status Database User.
O Running ANALYTICSADMIN
Host: Instance:
807ee9f4-54a9-4b94-9faf-be2540e76fed.hana.prod-eul0.hanacloud.ondemand.com 0
se Q

22. Go to Catalog -> Remote
Source
23. Right click on the Remote [_4% =

Source and Add Remote "
Source -~ + [ C

Filter Databases
- | '_] hanacloud (807ee9f4-5459-4b94-9faf-be2540¢
w [ Catalog
@@ Adapters
&% Agent Groups
& Agents
f Column Views
(& Cubes
f Functions
= Graph Workspaces
El Indexes
© JSON Collections
B Libraries
C§ Procedures
5 Public Synonyms
[ Remote Sources ||

# Remote Subscriptions Add Remote Source

=B Schemas Show Remote Sources

& Sequences Import Catalog Objects

& Synonyms Export Catalog Objects

] Table Types Open SQL Console Ctrl+Alt+C
FH Tables Copy Name Ctrl+C
Tasks Refresh
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24. Fill in the remote source details: Add Remote Source

Source Name *Source Name | SQLServerl7

Adapter Name:

MssqlLogReaderAdapter *Adapter Name | MssqlLogReaderAdapter

Data Server Source Location | AGENT: dpagent_ri4 v

Database Name

Credentials Mode: Technical Property Value

user v Configurations

User Name

Password v Generic
Load and Replicate LOB colu... true v

~ Data Type Conversion

Create the remote source. Always Map Character Types ... false e
Allow Map Character Types t... true A
*Map SQL Server Data Type ... false A

~ Database

*Data Server (serverName[lin...

false

Www.yourservername.com

Port Number 1433
Create | | Cancel
25_ NOW, you can see the SQL Ca hanacloud (807ee9f4-54a9-4b%4-9faf-be2540e76fed hana.prod-eu10.hanacloud.ondemand.com:443): SQLSen
Server in the list of Remote ~ + @ C  sasenert? x

Source, open the remote
source SQLServerl7

Filier Da:
Fitter Da

- J hanacloud (807¢e9f4-54a¢
- Catalog
.@Adapters
& Agent Groups
& Agents
ff Column Views
9 Cubes
i Functions
4 Graph Workspaces
[Z Indexes
© JSON Collections
B Libraries
8 Procedures
5H Public Synonyms
& Remote Sources
@ Remote Subscriptions
=2 Schemas

+ Seauences

 RemoteSources Q

@ MySQL80

& 5S4 R4

@ SQLServerl7

E&: SQLServerl?7

Adapter Name: MssqllLogReaderAdapter

Source Location: agent - dpagent_rid

Remote Objects Dictionary Statistics

Collapse all

Display Name Description
> INFORMATION_.

> db_accessadmin

~

db_backupopera..
> db_datareader

> db_datawriter

~

db_ddladmin

~

db_denydatarea...

~

db_denydatawriter

~

db_owner

~

db_securityadmin

Exceptions

Create Virtual Object(s)

Unigue Name

INFORMATION_SCHE
db_accessadmin
db_backupoperator
db_datareader
db_datawriter
db_ddladmin
db_denydatareader
db_denydatawriter
db_owner

db_securityadmin
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26. Go to schema dbo -> Tables .
27. Select all 3 tables and Create
Virtual Object(s)

SQLServerl? x

|;8: SQLServerl7

Adapter Name: MssqglLogReaderAdapter

Source Location: agent - dpagent_rid

Remote Objects Dictionary Statistics Exceptions
Collapse all
Display Name Description

> db_securityadmin
v dbo

> Procedures

~ Tables
v CountryCode
v Region
v Sales

Create Virtual Object(s)

Unigue Name

db_securityadmin

dbo
PROCEDURE_REQUE...
Tables_dbo
"dbo"."CountryCode"
"dbo"."Region”

"dbo"."Sales"

28. Optionally, give the Virtual
Objects a prefix and select a
schema to create the virtual
tables.

Create Virtual Objects

Enter a prefix for object names and select target schema

Object Names Prefix: | y_

Schema: DBADMIN

Create | | Cancel
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29. Once the virtual tables are 5 Synonyms
created, they will appear under _
the Tables of the selected [ Table Types
schema. BH Tables
#2| Tasks
% Triggers
FEB Views
b Database Diagnostic Files

HDI Containers
» & hanacloud (8072e9f4-54539-4b94-Sfaf-be2540:¢

AMALYTICSADMIN &

- —
> lables

2E3rcn

Jo)

F4. V_CountryCode

F& V_Region

==

A V_Sales

3.3 Create User-Provided Service (UPS)

Before building a SAP HANA Database project in SAP Business Application Studio, we need to create a User-Provided
Service in SAP Business Technology Platform (BTP) subaccount. This USP will be used by the HANA project to connect
to SAP HANA Cloud.

Explanation Screenshot
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30. Navigate to SAP BTP Cockpit

31. Click on Service -> Instances : , ; — I
@ Applications & SAP Internal - P&T CEE (CPEA) v 52 P&T Global PROD v = PROD v

¥ Services N SAP HANA Cloud

Service Marketplace

I Instances I

& SAP HANA Cloud

P SAP HANA Database Instances
@ Routes

&8 Security Groups hanacloud
E_ Events @
B Memory CPU Storage
& Members 30GB 2VCPUs 120 GB
Actions v
32. Create a User-Provided = B sareTe Cockeh R
Serv|ce |nstance @ Applications @ SAP Internal - P&T CEE (CPEA) v | £ P&T Global PROD = PROD v
¥ Services v Space: PROD - Service Instances
Service Marketplace Service Instance )

User-Provided Service Instance
Instances Search Q | | All Services ~

& SAP HANA Cloud

@ Routes

Instance = Service Plan Credentials Status
&8 security Groups ans Alert Notification standard 1key [ created |
P— CalculationVi.. ~ SAP HANA Schem...  hdi-shared Jkeys [ createa |
. CSTORE Credential Store standard [ Created |
& Members
hanacloud SAPHANACloud  hana [ created |

(2 Kevin v @)

Create '

‘ Service Instance

I User-Provided Service Instance !

1 ]
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33. Enter Instance Name Update User-Provided Service Instance
34. Specify the parameter in JSON
format: Instance Name: *
"hOSt"Z ||<Y0ur SAP HANA | AnalytichPS |
Cloud SQL End>", System Logs Drain URL:
llportll: |I443Il, | p—— |
"user": "ANALYTICSADMIN", il i
"password": "Welcomel", Route Service URL:

"tags": ["hana"| | Enter URL |

Configure instance parameters

Upload a JSON file:

Please select a file | Browse...

Specify the parameters in JSON format:

Clear
T
2 "host™: " .hana.prod-eull. hanacloud
.ondemand.com”,
3 "port™: "443",
£ "user™: "ANALYTICSADMIN®,
5 "password”: "kWelcomel",
6 "tags": ["hama"(]
i )

m Cancel

35. The UPS instance is created in s

= Service Plan Credentials Status
the I|St AnalyticsUPS User-Provided m ° ’
ans Alert Notification standard 1key m @ bd
CalculationVi. SAP HANA Schem.. hdi-shared 3 keys m = >
CSTORE Credential Store standard [ Createa | - >
hanacloud SAP HANA Cloud hana m aee ?

3.4 Create SAP HANA Database Project with HDI Container

In this section, we will create an SAP HANA Database Project in SAP Business Application Studio, deploy the project
into SAP HANA Cloud as a HDI container.

Explanation Screenshot
36 Na\”gate tO SAP BUSineSS SAP Business Application Studio Ll)
Application Studio
37. Create a new Dev Space
Dev Spaces

Create and manage your development environment

according to the type of applications you want to
develop.

‘You can add extensions and tools to further enhance

your development options.
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38. Enter a Dev Space Name

39. Select SAP HANA Native
Application

40. Click Create Dev Space

Create a New Dev Space

HANA v

What kind of application do you want to
create?

@ SAP Fiori

<

m Full Stack Cloud

= ppplication

o SAP HANA Native
Application

SAP HANA Native Application Dev Space

Build and deploy native SAP HANA applications or analytical models, This dev space cantains a comprehensive set of
editors to support the creation of database artifacts (calculstion views, tables, SQLSeript procedures, and more), as
well as tools to enable an end-to-end development flow from praject creation to the deployment to the SAP Cloud

Platform.

SAP Predefined Extensions
The following extensions are enabled by default.

Basic Tools

< ‘3? Allows you to eptimize your web
development workflow. The...

O SAP HANA Calculation View Editor

ST Allows you to edit and manage SAP

§ % HANA calculation views. The...
N more

Additional SAP Extensions
Select additional extensions to enhance your space.

SAPUIS Adaptation Project
Allows to extend SAPUIS
applications using Adaptation
project and Visual Editor

CDS Graphical Modeler
Allows you to design SAP core
data services models in SAP...
more

PPN SAP HANA Database Explorer P SAP HANA Performance
41. Wait until the dev space status
Changed to RUNNING [?8$ RUR 63/‘25/2021 8:41 ws- @ i @
42. Click on Dev Space Name NP cenane - 265 @

Application

43. Create a new project by click
on Start from template tile

File Edit Selection View Go
EXPLORER

~ NO FOLDER OPENED

You have not yet opened a folder.

Open Folder

You can also clone a repository from a URL. To
w 1o use git and source

learn more about
control in VS Cod

d our docs

Clone Repository

You can create a project using buift-in
templates.

Create Project

Terminal  Help SAP Business Application Studio - HANA

Welcome X

\
£V

SAP Business Application Studio

Featuring

E@‘S SAP HANA Native Application

o

e o

Start from Clone from Git Import Files & Folders
e lat
it Clone Git project Import files to your Open files and
Create a new dev space folders

project
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44, Select SAP HANA Database

Project
45, Click Start

New Project From Template

Select Template
@ and Target
Location

Select Template and Target Location

Specify a target folder path @ Preferences

/home/user/projects

Templates (2) *

Basic Multitarget
Application

SAP HANA

Database Project
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46. Enter a Project Name

New Project From Template

47. Click Next
Select Template Add Basic Information
[ ] and Target ) L o
° Add Basic Project Mame
Information CalculationViews
48. Click Next

New Project From Template

act Template Set Basic Properties

. -
Enter the module name
o db
Set Basic
e Properties
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49. Select HANA Cloud as SAP
HANA Database Version
50. Click Next

New Project From Template

Set Database Information

Mamespace

Schema Name

@ Sef Database SAP HANA Database Version *

Information
HANA Cloud v
Bind the database module to a Cloud Foundry service
instance? ()

® vYes O No

July 2021

23



SAP HANA Cloud: Live Analytics Across All Your Enterprise Data

SAD4

51. Enter the e-mail address and
Password

52. Select the Cloud Foundry Org
and Space

53. Click Finish

New Project From Template

Bind to HD!
@ Container
service

Bind to HDI Container service

Enter Cloud Foundry endpoint

https://api.cf.us10.hana.ondemand.com

Enter e-mail address

kevin.li03@sap.com

Enter Password

BRARERERE AR T

Choose Cloud Foundry Org *

4e2198f75trial b

Choose Cloud Foundry Space *
dev v

Create a new HDI service instance?

® ves O No

Flease enter a unigue and non-existing service
instance name

CalculationViews-hdidb-ws-2fxz5

Use the default database instance of the selected
Cloud Foundry space?

® Yes (O No

I KT
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54. Click Files & Folders tile

\
£V

SAP Business Application Studio

Featuring

E@% SAP HANA Native Application

e ® £ r

Start from template Clone from Git Import Files & Folders
Create a new project Clone Git project Import files to your Open files and
dev space folders

55. Go to projects

56. Select the project
CalculationViews

57. Click Open

< # 1 [ projects
~ [ projects
~ @ CalculationViews
> mdb
¢ gitignore

£ mta.yaml
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58. The project will get some basic <> File Edit Selection View Go Run Terminal Help
2gliztﬂ;ef1§f shown in the @ EXPLORER Welcome mtayaml X package-lock.json
H \/ CALCULATIONVIEWS 1 _schema-version: "2.1"
59. Click on m_ta'yaml v mdb 2 ID: CalculationViews
60. In code editor, you need to add jo, R 3 version: 0.0.1
. . noae_modules
the User-Provided Service to e 4 modules:
the project using the following %9 el 5 - name: db
de: 1 hdiconfig 6 type: hdb
coae: & env 7 path: db
- name: AnalyticsUPS o gitignore 8 | requires:
.. ; 9 - : hdi_db
type: org.cloudfoundry.existing- packane lock g 16 gﬁ:;eng.
. "1 k i f .
service [..l > ?f’c T 11 TARGET_CONTAINER: ~{hdi-container-name}
@ gignore 12 ‘ |- name: AnalyticsUPS |
@ s mta.yaml 13 resources:
e 14 - name: hdi_db
15 type: com.sap.xs.hdi-container
[> 16 properties:
17 hdi-container-name: ${service-name}
L 18 - name: AnalyticsUPS
‘ NS 19 type: org.cloudfoundry.existing-service
61. Expand the SAP HANA 14 name: hdi_db
Projects -> CalculationViews/db P AR PRBIEEE 15 type: com.sap.xs.hdi-container
-> Database Connections -> VB Calcitaliomiewalb 15 properiies;
AnalyticsUPS AP AONN Y 7 hdi-container-name: ${service-name}
62. Click Bind v [Y Database Connecti 18 name: AnalyticsUPS
63. Select Bind to a user £¥ hdi_db (Calculation... 19 type: org.cloudfoundry.existing-service

provided service
64. Select AnalyticsUPS

¥ AnalyticsUPS E
Select a binding option

Eind to an HDI container

Bind to a user provided service

Select a user provided service

KevinUPS user-provided

AnalyticsUPS user-provid

The AnalyticsUPS service has been bound. x
65. Go to View -> Find £3  File Edit Selecion View Go Run Terminal Help
Command... N
@ EXPLORER Find Command... Ctrl+Shift+P
~ CALCULATIONVIEWS Open View...
v mdb Call Hierarchy Ctrl+Shift+F 1
> @ node_modules Debug Ctrl+Shift+D
%9 T Debug Console Ctrl+Shift+Y
% hdiconfi
contg Explorer Ctrl+Shift+E
& env
@ » Extensions Ctrl+Shift+X
£ _gitignore
. . Outline CtriHShift+
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66. Search for Create SAP HANA
Database Artifact >create sap hana databasd

67. Click on it SAP HANA: Create SAP HANA Database Artifact

68. Select Grants as Artifact Type
69. Enter Artifact name
70. Click Create

Welcome Create SAP HAMNA Database Artifact =

Create SAP HANA Database Artifact

Choose path where you want to create the artifact.

/home/user/projects/CalculationVie |

Choose Database Version *

HAMA Cloud v

Artifact Type (@) *

Grants (hdbgrants) v

Artifact name @ x

Analytics

71. Cllck on AnalytICS.hdbgrantS EXPLORER Welcome Analytics hdbgrants x
72. Delete the default grants in ~ CALCULATIONVIEWS ; L amalyeicsps' |
code editor, and enter the v b B S “object ounar: {
following JSON: 7 W rodemot 4 "schema_privileges”:[
. ~ I src 5 {
{ Hi hdiconfig 6 "preference” :"ANALYTICSADMIN",
"AnalytichPS" : { Il Analytics.hdbgrants 7 "privileges_with_grant_option™:["SELECT","EXECUTE"]
"object_owner": { b ; :
w_ .. © gitignore _9 1
SChema_perIlEg package-lock json 18 i’ . . .
eS" . [ P 11 application_user™: {
¢ P 954 12 "schema_privileges":[
4 _gitignore 13 {
n ", £ mta.yaml 14 "reference” : "ANALYTICSADMIN®,
" " r‘e'Fer‘ence . 15 "privileges_with_grant_option™:["SELECT"]
ANALYTICSADMIN", 16 1
" .. 17
privileges_ 18 ! !
with_grant_option":["SELECT" i 3 ¥
, "EXECUTE"]
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]
s
"application_user":
{
"schema_privileg
es":[

"reference":"ANA
LYTICSADMIN",

"privileges_with
_grant_option":["SELECT"]

}

]

73. In SAP HANA PROJECTS, we
can the project is in pending
deployment. Let’s deploy the
HDI container by click the
rocket button

v SAP HANA PROJECTS E Y O
v B CalculationViews/db (pending deployment) o1 Rod

v I src (pending deployment
B Analytics hdbgranis (pending deployment)
v [% Database Connections
{¥ hdi_db (CalculationViews-hdidb-ws-2fxz5)
% AnalyticsUPS (AnalyticsUPS)
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74. Navigate to SAP HANA
Database Explorer, the HDI
container should show up in the
list of databases.

Note: In case the HDI container
didn’t show up, you can manually
add the HDI container.

B | ) cB596752-9527-4e1d-8070-f46fb5cB8e389
w | | CalculationViews-hdidb-ws-2fxz5 (PROD)
fH Column Views
& Cubes

f# Functions

=% Graph Workspaces
El Indexes

© JSON Collections

B\ Libraries

£ Procedures

71 Public Synonyms

! Remote Subscriptions
#" Sequences

51 Synonyms

] Table Types

A Tahlac

3.5 Create Calculation View

Now we can create a calculation view with the virtual tables in HDI container.

When Calculation Views are executed in SAP HANA Cloud, the query is first optimized in a special engine called
“Calculation Engine”. This has a drawback when the query is included in a larger SQL query, because in this case two
different optimization processes are involved: One for the SQL query part and the other one for the Calculation View

part. This can lead to inefficiencies between the different optimization processes.

To avoid these inefficiencies, you can set the parameter “Execute in” to “SQL Engine” in Calculation Views. This can
push as much processing as possible to target data source. One exception is that this setting is active for Cubes with
Star Joins automatically even though the “Execute in” option is not set to “SQL Engine”. MDS queries often benefit from
setting the flag to “SQL Engine” in the topmost Calculation Views that are queried by MDS. SAP Analytics Cloud utilizes

MDS queries to retrieve the data from HANA Calculation Views.

Explanation

Screenshot
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75. Go to View -> Find £  File Edit Selecton View Go Run Terminal Help
Command... ~
@ EXPLORER Find Command... Ctrl+Shift+P
s CALCULATIONVIEWS Open View...
v W db Call Hierarchy Ctri+Shift+F 1
> W node_modules Debug Cir+Shift+D
%5} T Debug Console Ctrl+Shift+Y
% hdiconfi
contg Explorer Ctrl+Shift+E
& .env
@ » Extensions Ctrl+Shift+X
€ _gitignore
. .o Outline CtrHShift+
76. Search for Create SAP HANA
Database Artifact >create sap hana database]
77. Click on it .
SAP HANA: Create SAP HANA Database Artifact
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Artifact Type
79. Enter Artifact name Choose artifact that vou need for vour proiect
80. Click Create : : .

78. Select Calculation View as Create SAP HANA Database Artifact

Choose path where you want to create the artifact.

/home/user/projects/CalculationVie (.

Choose Database Version *

HANA Cloud W

Artifact Type (2) *

Calculation View (hdbcalculationvie v

Artifact name @ *

Sales

Label @

Sales

Data Category @ :

CUBE v

Use Star Join? (3)
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81. Create JOIN Welcome Sales hdbcalculationview X
82. Click Add Data Source
50 AW @ B = & |
» Jc
ao
P
o | Semantics
v 1
8 ]
g" Aggregation A
Eu @ Join_1

£
° ®
o Join_1 A

.@ Add Data Source

tg

83. Select AnalyticsUPS as the
External Services

84. Search “sales”

85. Select virtual table V_Sales
from schema
ANALYTICSADMIN

Find Data Sources

Search for an object name

EE ®

All Types Selected

86. Click Create Synonym External Services: | All Services Selected ~ |
Results (2) Selected Objects (1)
Type MName Schema Synonym
a7l V.Sales DEADMIN
v iril V_Sales ANALYTICSADMIN

Create Synonym
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87. Enter a Synonym Name

88. Click Finish

89. Repeat the steps 82-88 to add
another data source for virtual
table V_Region

Note: A Synonym file will be
generated under src folder.

Synonym Name

| calculationview.db::V_Sales

Synonym for HDI Container
- Object Owner Role :

- Application User Role :

Object Name

V_Sales

Find Data Sources

Schema Use Ex...

ANALYTICSA...

Generate .hdbgrants File

- Creating synonyms requires building hdbsynonym and hdbgrantor files after creating or modifying them.

90. JOIN 2 tables using column
Region ID

Welcome Sales.hdbcalculationview X

& HE " e n

>
@
® [E. Semantics
g Aggregation A
8 @ Join_1
[E]
E .. o5 .Q
] loin_ ~
= Hd
® [ calculationview.do . @
i) [ calculationview.db- @
T
o
&

Join_1

Join Definition  Mapping Calculated Columns (0)  Parameters (0) Colu

s

calculationview.db:V_Sales A [ calculationview.db::V_Region A
HegiantD o "® Mg egion 1D
Country AR Region
Item Type

Sales Channel

Order Priority

Order Date

Order ID

Ship Date

Units Sold

Unit Price

Unit Gost

Total Revenue

Total Cost

Total Profit
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91. Click on Semantics -> View
Properties -> Advanced
92. Select Execute In SQL Engine

Note: The parameter Execute in
‘SQL Engine’ improves the
performance of HANA calculation
views.

Semantics
View Properties Columns (14) Hierarchies (0) Parameters (0)
General Advanced Static Cache

A\ These properties may affect the output data. Set them cautiously.
Propagate Instantiation to SQL Views
Analytic View Compatibility Mode

Ignore Multiple Outputs For Filter

Pruning Configuration Table: QA | +
Execute In:| SQL Engine ol |
Execution Hints: ER e &
Name Value

93. Click Hierarchies

94. Enter Name

95. Add 2 Nodes:
Levell: Region
Level2: Country

Semantics

View Properties  Columns (14)  Hierarchies (1)

General
*Name; RegionLBH
Label: | RegionLBH
Notes:
Node Style: ame Path
» MNodes
+
Level Column Level Type Order By
1 Region A REGULAR =~ Region A
2 Country A REGULAR Country A

Parameters (0)

&3
Sort Direction
Ascending

Ascending

(¥
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96. Deploy the calculation view
into HDI Container

v SAP HANA PROJECTS E Y O
v I CalculationViews/db (pending deployment)
v B Src (pending deployment)

B Analytics hdbgranis

B AnalyticsUPS hdbsynonym

R Sales.hdbcalculationview (pending depio.. e 4
v [% Database Connections

{¥ hdi_db (CalculationViews-hdidb-ws-2fxz5)

<% AnalyticsUPS (AnalyticsUPS)

97. Congratulations! You have
created a calculation view in
SAP HANA Cloud

SAP SAP HANA Database Explorer

Filter Databases

+ | ] CalculationViews-hdidb-ws-2fxz5 (PROD)
ff Column Views
(@ Cubes
f8 Functions
= Graph Workspaces

Search ColumnViews Q| VY

Ef_.| Sales

ff Sales/RegionLBH/hier/RegionLBH

3.6 Create a story in SAP Analytics Cloud

Explanation

Screenshot
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98. Logon to your SAP Analytics
Cloud tenant.

99. Click on the Main Menu.

Catalog Fav

Today

Hello,

100. Select Modeler

X SAP Analytics Cloud

Home

Files

Stories

Analytic Applications

Digital Boardroom

Datasets

Modeler

Data Actions

101. Click on Live Data Model

Welcome to the Modeler

Prepare your raw data using a structured view and get started with your scenario analysis. Learn More...

Models Public Dimensions Currency Conversions Points of Interest

Create New

Model From a CSV or Excel File Live Data Model

From a Data Source
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102'_ Ente_r the following Create Model From Live Data Connection
information

System Type: SAP HANA
Connection: HANACIoud or
your HANA Cloud connection
Data Source: Sales

Select Live Data Connection and Data Source

*System Type:

. SAP HANA N
103. Click OK.

*Connection:

HANACLloud v

*Data Source:

ZBAPI_VBAK_TOTAL L
OK Cancel
104. Save the model. @ Data sources A B s X2 ® All Dimensions
ID Description Aggregation Ty... Exception Agg.
1 ost Total_Cost SUM
2 | Total_Profit Total_Profit SUM
3 | Tota enue Total_Revenue SUM
4 | Unit_Cost Unit_Cost SUM
5 | Unit_Price Unit_Price SUM
6 | Units_Sold Units_Sold SUM
105.  Provide the new Model a Save Model
name and save it in a directory.
My Files / Public / I¢ /5QL Server [0 | Alfiles v | Search Q
Name =  Description Owner
4, 60MillionSales - Kevin Li
% CopyofOneMillion - Kevin Li
., LargeSalesDataSet - Kevin Li
%, SOLDPRICE - Kevin Li
-'§'<_—a SQLCALVIEW - Kevin Li
%, SQLUNIONVIEW = Kevin Li
*Name

SQLCALVIEW

Description

OK" Cancel

July 2021 37



SAP HANA Cloud: Live Analytics Across All Your Enterprise Data ®

106. Select Stories X SAP Analyties Cloud < SAP [ stories
107. Select Responsive & Home
Welcome to Stories
= E= Create a story to visualize, summarize, explore, and monitor your data. Add charts, tables, text, and other objects, and share you
Apps
Create New
[ Stories
¥ Analytic Applications
£71 Digital Boardroom Responsive Canvas Grid From a Smart Discovery
% Datasets Templates
®  Modeler 2ot 2w 2o 231 239
5. Data Actions
Analytic Template V1 New Document(3) Templ... table template
108. Remove one of the + Addlane >
responsive pages. @ Copy >

& Edit Styling...

109. Insert a Chart. 70103 Files / New Document* +r

~ File Insert
Story [EE! A g - A El i = B
110.  Select the model. Save Medel
My Files / Public / 1€ / SQL Server O All files ~ Q
MName =  Description Owner
%L 60MillionSales - Kevin Li
%, CopyofOneMillion - Kevin Li
%, LargeSalesDataSet - Kevin Li
% SOLDPRICE - Kevin Li
%5 SQLCALVIEW - Kevin Li
%, SQLUNIONVIEW - Kevin Li
*Name
SQLCALVIEW

OK" Cancel
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111. Select Unit_Cost and
Unit_Price as the measures,
and the hlerarChy ReglOﬂ_Lbh uUnithnst,UmtﬁPnce per Region Lbh P mson Trend Djsu‘lmt on
as the Dimension. ' pricon o oo EX e "

112.  The chart looks like the comman poe o

202,106,213.0000 E v @ ~ 0 ~
screenshot. AT RS

~ Chart Structure +

7] Y Axes Overlap
Measures
Column Axis
i Unit_Cost ®
+ Add Measure
Line Axis

¢ Unit_Price ®

+ Add Measure
Dimensions
i Region Lbh ®

+ Add Dimension

113. Cl!Ck on the ba.r- Unit_Cost, Unit_Price per Region Lbh
114.  Click on the Drill Down.

S
Unit_Cost - Unit_Price

115. Note: This drill-down
analysis is enabled by the 202,106,213.0000
hierarchy created in HANA. |
This is an added value that o |
HANA can build hierarchies on V@
flat data structure in source
tables.

K¢

4

116. The Chart will show based Unit_Cost, Unit_Price per Region Lbh
on the regions.
117.  Save the story.

.
a

Unit_Cost & Unit_Price

Y

July 2021 39



SAP HANA Cloud: Live Analytics Across All Your Enterprise Data

July 2021

40



SAP HANA Cloud: Live Analytics Across All Your Enterprise Data m

4. Setup Connection to SAP ERP

In this section, we will setup SAC live data connection to SAP ERP using SAP HANA SDI (Particularly, SIAHANA on-
premise is used in this section, but the same setup can generally apply to SAP ECC 6.0). In the previous sections, we
have configured SAC live data connection to Microsoft SQL Server using SAP HANA SDI. SDI can also connect to
various types of SAP data, for example, SAP ERP systems. Here, the ABAP adapter is used to retrieve data from virtual
tables through RFC for ABAP tables and ODP extractors.

Currently, SAP Analytics Cloud only has acquired data connection to SAP ERP systems. With ABAP adapter, SAC can
live connect to SAP ERP systems. The system landscape is started with installing and configuring Data Provisioning
Agent. The ABAP adapter not only enables virtual tables mapping to the ABAP tables, but virtual procedures can also
be mapped to the BAPIs in SAP ERP. Both virtual tables and virtual procedures can be used to create calculation views
in SAP HANA Cloud, and then SAC consumes the calculation views through live data connection to SAP HANA Cloud.
The system landscape is setup as below.

roc
o PrOC8uzg

&
—PLr
»
ABAP Adapter _—— E
-\ b
Live Connection (RFC) —
: . —

SAPTERP

'DSno ’\0%

MDS QueN
SAP Analytics Cloud SAP HANA Cloud

Database

Since ABAP adapter exposes three types of data: ABAP tables, BAPIs, and ODP extractors to SAP HANA, it is important
to decide which types of data can be used in this scenario. The ODP extractors includes CDS views, SAP BW, and SAP
HANA, SAC already has live data connection to these data sources. Hence, ODP extractors can be excluded in this
scenario. Again, the rule of thumb is to reduce the data transfer across the network. In this case, it is to push down as
much processing as possible to SAP ERP’s database. SAP AS ABAP cannot process SQL query from SAP HANA
Cloud, so SAP HANA Cloud cannot push down query processing to SAP ERP. That means the raw query result on
virtual tables mapped to ABAP tables need to be returned to SAP HANA Cloud, which will cause poor performance if
the size of the ABAP tables is too large. Thus, the only option is to use BAPIs in SAP ERP. BAPIs can push the query
down to SAP ERP’s database if coded accordingly and return the aggregated result set to SAP HANA Cloud.

4.1 Register ABAP Adapter in SAP Data Provisioning Agent

The ABAP adapter retrieves data from virtual tables through RFC for ABAP tables and ODP extractors. The
ABAPAdapter is a build-in adapter in Data Provisioning Agent, so we can directly register the adapter without
downloading any drivers.
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Explanation Screenshot

118. Select option 8. Adapter
Registration Con ation Tool

M=

[a BN I =

1

119. Select option 2. Register
Adapter

120. Enter adapter name:
ABAPAdapter

The adapter name must match | ER er Adapter
the name displayed by the '
Display Adapters option.

T Name :

'ABAPAdapter” successfully registered.

4.2 Add SAP ERP as a Remote Source

Now, we will connect to SAP ERP using ABAPAdapter in Data Provisioning Agent. In this document, S/4HANA is used
as an SAP ERP system, but an older SAP ERP system (SAP ECC) will also work in this case.

Explanation Screenshot
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121. Navigate to SQL Console

122. Goto Catalog -> Remote
Source

123. Right click on the Remote
Source and Add Remote
Source

SAP SAP HANA Database Explorer

Filter Databases

~ [ hanacloud (807ee9f4-54a9-4b94-9faf-be?540¢

w [ Catalog
o Adapters
&% Agent Groups
& Agents
HH Column Views
(7 Cubes
f Functions
=sa Graph Workspaces
El Indexes
© JSON Collections
=i Libraries
% Procedures
A Public Synonyms
. Remote Sources
@ Remote Subscriptions
=2 Schemas
& Sequences
Bl Synonyms
] Table Types
fH Tables

Tasks

Add Remote Source

Show Remote Sources

Import Catalog Objects

Export Catalog Objects

Open SQL Console Ctrl+Alt+C
Copy Name Ctrl+C

Refrash
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124. Fill in the remote source Add Remote Source

details:

Source Name *Source Name | 54_RI4

Adapter Name: ABAPAdapter

Application Server *Adapter Name | ABAPAdapter

Client

Instance Number Source Location | AGENT: dpagent_rid e

Credentials Mode: Technical

user Property Value

User Name

Password v Connectioninfo

Connection Type Custom Application Server

125. Create the remote source. *Anplication Server yourSAPERPhost

Message Server

Message Server Port

*Client 400
*Instance Number 00
System ID

Server Group

Connections Pool Size 10
Connections Limit 100

Create Cancel
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126. Now, you can see the SAP E= anacloud (80720f4-5420-4b04-Ofaf-be2540e76f4 hana prod-eu10 hanacloud ondemand.com:443): €
ERP system in the list of ~ + [ C SQLConsole Lsgl x | S4_RI4 x
Remote Source, open the
remote source S4_RI4, BAPI = s . sa Ris [ it |
Procedures, along with ABAP & Procey ' N
tab|eS and ODP extractors are ligublclz Adapter Name: ABAPAdapter
. emote
the data aVa"abIe from SAP 7 Remote Source Location: agent - dpagent_rid
S/4HANA olE Schema Remote Objects Dictionary Statistics Exceptions
& Sequen —
& Synonyl
B Table Ty Collapse all
f Tables
Tasks Display Name Description Unigque Name
5 Triggers > Extractors All SAP Extractors exp... | Extractors
2 Views
> BAPI Procedures ALl BAPI Procedures BAPI
Search Remoi Q > ABAP Tables by t... Al ABAP Tables by ta... ~ ABAPTABLES
@ Ha > ABAP Tables by ... | ABAP Tables by applic... = ABAPTABLES_APPLHI...
@ MysaLso
& s4 RM4
@& SQLServerl?

4.3 Create Custom BAPIs in SAP ERP

In this section, we will first create a structure in SAP NetWeaver AS ABAP, and then create a function module to return
the aggregated data back from SAP ERP’s database. Lastly, we will add this function module into a custom BAPI and
publish the custom BAPI.

Explanation Screenshot
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127.  Logon S/4HANA in < SAP ABAP Dictionary: Initial Screen
SAPGUI.

| ~ | o »x B B [E Morew Q & Exit

128. Go to transaction SE11.

Database table | |

(O O]

View | |

Data type

|
Type Group |:|

o O

Domain | |

Search help | |

O O O

Lock object | |

&0 Display ] [ # Change ] [ {1 Create ]

129. Select Data type. | vl ® 2 B & G Moev Q 8 B

130. Enter a custom BAPI name.

131. Click Create.

(O Database table | |

O View

(® Datatype [zBaPTSTRVBAK |

O Type Group

() Domain

(O Search help

(O Lock object

[ &0 Display ] [ & Change ] I {] Create ]
132 Select Structure. = Create Type ZBAPISTRVBAK X
133. Click OK.
() Data element

)

Table type

C

O
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134.  Enter a Short Description. & B % » Moev Q Q@ T Ext

135. Enter the Component (Field
Name) and Component Type

(Data Element) as shown in the
screenshot. Attributes Components Input Help/Check Currency/quantity fields

Note: Here the component names

start with Z as per the SAP

Structure: |ZBAPISTRVBAK | Active

* Short Description: IStructrue for bapi from table vbak l

. ' C t Typing Method C t Ty Data T L h D
recommendation. Let's use data ompenen LBl tiiuiot el it sy
[T] vBTYP Types v VBTYP CHAR 1
elements that we have already =
X [] ERNAM Types \ ERNAM CHAR 12
created in the database table O] NEToR " ——— s —
VBAK.
136. Enter the PaCkage Z001. = Create Object Directory Entry X
137.  Save the structure.
Object: |R3TR "TABL "ZBAPISTRVBAK
Attributes

Package: | I

Person Responsible: | 1841302

Original System: |RI4

Original language: English

@ | Local Object Lock Overview Mg X

138.  Click OK.

Prompt for transportable Workbench request x

Table: | ZBAPISTRVBAK

Request: |R 6 Workbench request

Short Description: |tmp |

¥ (] OwnRequests X
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139.  Activate the structure. vl v @ o» Nisraso Q o B &t
Structure: }iBAPISTRvsAK
* Short Description: iStructrue for bapi from table vbak
Attributes Components Input Help/Check Currency/quantity fields
Component Typing Method Component Type Data Type Length Dec
O Types + VBTYP CHAR 1
[] ERNAM Types + ERNAM CHAR 12
[C] NETWR Types v NETWR CURR 15
140.  Go to transaction SE37. < SAP Function Builder: Initial Screen
141.  Enter a new Function " Ol B % F B I Meev Q 8 &t
Module name.
142.  Click Create.
Function Module: [ZBAPT_VBAK_TOTAL ]
L 63 Display ] [ / Change J [ ] Create ]
143. Enter Function group. = Create Function Module X
144.  Enter a Short description.
* Function Module: |ZBAPT_VBAK_TOTAL |
Note: If function group is not _ “Function group: [ZBAPT_KEVIN |
already made, you could create it
. * Short text: ITest |
by following steps 39-41.
x
145. Go to More -> Goto -> < SAP Function Builder: Initial Screen
Function Groups -> Create T 0F F B 0wy Qg e
Group. Detete
Copy. (Cr+F5)
Rename. (CUr+F6)
Function Module: [ZBAPT_VBAK_TOTAL .
Reassign.. (CUL+F7)
Cancel (F12)
63 Display ] [ # Change ] E Function Module >
Edit >
Goto > Global Data (Shift+Ctri+0)
Utilitieg > Master Program  (Curl+Shift+Fs) ‘
Enyironment > Function Groups Create Group
System > Obiject Directory Entry Change Group
Help > Documentation Display Group
SAP GUI settings and actions > Translation Delete Group

Online Manual (Ciri+F8)

Back (F3)

Find Group

e
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146.  Enter a Short description. = Create Function Group X
147.  Save the Function Group.
Function group: |ZBAPI_KEVIN
* Short text: |Test
* Person Responsible:
v Save
148. Enter a PaCkage- = Create Object Directory Entry x
149.  Click Save.
Object: [R3TR |FUGR |ZBAPT_KEVIN
Attributes
Package: |m
Person Responsible:
Original System: |RI4
Original language: English
Local Object Lock Overview W& X
150. Click on Import. °| B 2 B Moev Q o @ ki
151. Add VBTYP as a import ‘
parameter. Function module ‘ZBAPI_VBAK_TOTAL | Active
Attributes Export Changing Tables Exceptions Source code
Parameter Name Typing Associated Type Default value Opti... Pass... §
BTYP. TYPE  ZBAPISTRVBAK-VBTYP O ¥ st
152.  Click on Export. 1 vl & B 2 B Morev Q O @ Exi
153. Add RETURN as a export :
Function module: |ZBAPI_VBAK_TOTAL ‘ Active
parameter. :
Attributes Import Changing Tables Exceptions Source code

Parameter Name Typing

RETURN TYPE

Associated Type Pass by Va... Short text

BAPIRET2 4 Return Parat
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SAD4

154. Click on Table. v‘ & B £ B Morev Q o B Eit
155. Add ITEMTAB as a table,
the Associated Type iS the Function module: ‘ZBAPI_VBAK_TOTAL ‘ Active
structure ZBAPISTRVBAK. Attributes Import Export Changing Exceptions Source code
Parameter Name Typing Associated Type Optional Short text
ITEMTAB LIKE ZBAPISTRVBAK O Structure for
O
156. Click on Source code. v & B B £ Moewv Q o B Ex
157.  Enter the following code: : .
Function module ‘ZBAPI_VBAK_TOTAL | Inactive
SELECT vbtyp ernam SUM( Attributes Import Export Changing Tables Exceptions

netwr )
FROM vbak
INTO TABLE itemtab
WHERE vbtyp = vbtyp
GROUP BY ernam vbtyp.

Note: The above ABAP code is to
push the aggregation to the
S/4HANA’s database. Retrieving
the aggregated result is critical for
performance.

158. Click Save.

1: CJFUNCTION ZBAPI VBAK TOTAL.

12 SELECT vbtyp ernam SUM( netwr )
13 FROM vbak

14 INTO TABLE itemtab

15 WHERE vbtyp = vbtyp

16 GROUP BY ernam vbtyp.

12 | ENDFUNCTION.

v
<>

Cancel

159. Activate the Function
Module.

Q d @ Exit

Exceptions

v‘ &3 Bl Z More v

Function module: }ZBAPI_VBAK_TOTAL

Attributes Import Export Changing Tables Source code

1; B FUNCTION ZBAPI VBAK TOTAL.

&

12 SELECT vbtyp ernam SUM( netwr )
13 FROM vbak

4 INTO TABLE itemtab

15 WHERE vbtyp = vbtyp

16 GRCUP BY ernam vbtyp.
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160. Go back. Function Builder: Initial Screen
_ B X F B OB Meew Q 8 e
161. Release the function [ —
module by More -> Function Copy..
Module -> Release -> Release. - [T 2:
Cancel (F12)
( 63 Display J [ # Change J C Eunction Module > | Create )
Edit > Change (F8)
Goto > Display F7
Utilities. > Check >
Environment > Activate  (Ctrl+F3)
System > Execute >
Help > Release > Release
SAP GUI settings and actions > Print... (Cul+P) Internal Releage

Gther Functions Cancel Release

Exit (ShiftF3) Function Module Obsolete
162.  Go to transaction SWOL. < SAP Business Object Builder: Initial Screen
163.  enter the name of the v 2 & B M0 Qa @ e
custom BAPI.
164. Click Create.
Object/Interface Type:
Category
(®) Object type [ F Test ]
A

Q) Interface type

63 Display ] [ Z Change ] l (] Create ]

165. Enter the details as shown

Create Object Type

in the screenshot.

166. Click Save. Supertype: ‘ ‘
* Object Type:
* Object name IZBAPI_KEV I
*Name: |ZBAPI_KEV |
* Description: IBAPI created by Kevin I

* Program: ‘IZBAPI_KEV_PRO6

* Application:
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167. Enter a paCkage Z001. = Create Object Directory Entry X
168.  Click Save.
Object: [R3TR | s0B1 [zBAPT_KEV
Attributes
Package: |2001 I
Person Responsible: 1841302
Original System: |RI4
Original language: English
Local Object Lock Overview W& X
169. Click OK. = Prompt for transportable Workbench request x
Business object types: |ZBAPI_KEV
Request: |_§ Workbench request
Short Description: |tmp
¥ [ OwnReguests X
170.  Select More -> Utilities -> < SAP Change Object Type ZBAPI_KEV
API Methods -> Add Method. [ V% & 2 6 e Qa a @ e
Object type ZBAPI_KEV v BAPI created by Ke| Choose °
Note: There would be two methods, Tesxsats
. . . —@ Interfaces Create
showing in red color which comes v T S
H H [—@ Attributes
by default while creating the BAPI. o Rename
Delete (Shift+F2)
ZBAPI_KEV.ExistenceCheck |  Documentation (Ct
ZBAPI_KEV.Display D p
Parameters
Exceptions
Object Type >
Events
Edit >
Goto >
Utilities X Color Legend
< —— Settings > API Methods > Add Method ~ (Shift+F4)
System S Change Requests (Organizer) (Ctri+F4)
Help > | Versions >
SAP GUI settings and actions >
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171. Enter Function module
name.

172.  Click OK.

Create AP| Method: Method Properties

* Function module

ZBAPI_VBAK_TOTAL

173. Click Next.

Create APl Method: Method Properties

* Function module: | ZBAPI_VBAK_TOTAL

Texts

Properties

[] Dialog

&

&

Synchronous

Method: | ZbapiTotal

Name: [TEST

Description: |TEST

Instance-independent

v [>] %

174. Click Next.

Create API Method: Create Parameters

@

July 2021
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175. Click Yes.

Extend Program X

Method ZBAPITOTAL not yet implemented

Do you want to generate a temp(ate

automatically for the missing section?

| Yes ] ( No J[ cancet |

176.  Now the APl method has < SAP Change Object Type ZBAPI_KEV
been added.

‘ v 6 & f & More v Q o @ Exi

177. Double click on the API

method. Object type ZBAPI_KEV . BAPI created by Kevin

—0G@ Interfaces
Key fields
—0 Attributes
F—0= Methods

ZBAPI_KEV.ExistenceCheck Check existence of object
ZBAPI_KEV.Display Display object

ZBAPI_KEV.ZbapiT001 v B TEST
ZBAPI_KEV.Zbapivbak v B TEST
—fZBAPI_KEV.ZbapiTotaﬂ v B TEST ]
Events
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178. Select API Function. = Method ZbapiTotal X
179.  Click Save.
Method: | EYSREREN
Release: [753
Status: |released
Name: |[TEST
Description: |TEST
General Result type ABAP
(O Function module
(O Transaction
(O Dialog module
O Report
O Other
MName: [ZBAPI_VBAK_TOTAL
a x
180.  Click Save. < SAP Change Object Type ZBAPI_KEV

\/‘ & & § & More v

Object type ZBAPI_KEV v BAPI created by Kevin

—0@ Interfaces

Key fields
—0&@ Attributes
F—0 Methods

ZBAPI_KEV.ExistenceCheck
ZBAPI_KEV.Display

ZBAPI_KEV.ZbapiT001 v B TEST

ZBAPI_KEV.ZbapiVbak v B TEST

ZBAPI_KEV.ZbapiTotal v B TEST
Events

Display object

Q O @ Exit

Check existence of object

<>

Save Without Checking [eELI-

~
v
~
v
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< Change Object Type ZBAPI_KEV

% & 3 8§ "More v Q a @ Ei
. J

181. Select the Object
“ZBAPI_KEV".

Choose F2)

object type ZBAPI_KEV . BAPI created by Ke hd
182 Go to More > Edlt -> 0 Interfaces ::‘:“m
Change Release Status -> o nas -
Object type --> To modeled. o et i .

< Documentation
D
Program
ZBAPI_KEV.ZbapiT001 v ET
ZBAPI_KEV . Zbapivbak » M Paematers )
ZBAPI_KEV.ZbapiTotal +vERT Exceptions
Object Type
Events
Edit > Choose F2
Goto > Test/Execute F8)
Utilities > Create =
< >
Seftings >|  Redefine Fo
System > Rename -
Help > Delete (Shift+F2

SAP GUI settings and actions Change Release Status Object Type To modeled

Cancel r Object Type Component To implemented

To reteased

To obsolete

Change Object Type ZBAPI_KEV

183. Goto More -> Edit -> < SAP
Change Release Status ->

S a 3 & Mora:n
v a

- Choose 2) g
ob ect t e > TO Object type ZBAPI_KEV v BAPI created by Ke
| yp Testecuts
i”]ple”]e nted (—@ Interfaces Crodte -
Key fields Redefine
(—@ Attributes
|| s2 st Rename 7
Delete (Shift+F:
ZBAPT_KEV. Existencecheck d  Decmstatics
Display o
s Program +Shift+F3)
ZBAPT_KEV.ZbapiT00L .|
ZBAPT_KEV.ZbapiVvbak , m 7 Parameters
-ZBAPI_KEV.ZbapiTotal +AT Exceptions
Object Type >
Events
Edit Choose F2
Goto TesvExecute G
Utilities Create F
« > I
Settings > | Redefine "
System > | Repame F7
Help Delete (shif+F:

SAP GUI settings and actions

Change Release Status >

Object Type

Cancel F12

Object Type Component

To modeled
To implemented
To released

To obsolete

184. Goto More -> Edit ->
Change Release Status ->

> R4@1)400 A o

Change Object Type ZBAPI_KEV

—
% @& 3 & Morev Q o Exit
bj | d =
Object type --> To released. _ :
Object type ZBAPI_KEV . BAPI created by Ke
TestExecute (F8
[—@ Interfaces Create (F5
Key fields Redefine (76
|—@ Attributes
Rename (F
— Methods
Delete Shift+F2)
-gnwl KEV.ExistenceCheck C  Bacimeniatica
ZBAPT_KEV.Display D
Program
-ZBAPI_KEV.ZbapiT001 v T
ZBAPI_KEV.ZbapiVbak v m 7 Parameters
ZBAPI_KEV.ZbapiTotal v B T Exceptions (CUrtsShift+F8
Object Type
Events
Edit > Choose F2)
Goto > TJest/Execute 8)
Utilities > Create
< >
Settings Redefine F6)
System Rename £7)
Help Delete Shift+F2

SAP GUI settings and actions

Change Release Status >

Object Type

Cancel F

Object Type Component

To modeled
To implemented
To released

To obsolete
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185, Select the APl method.

& & 3 & :Mumvj QA ¢ § e
186. Go to More -> Edlt -> Object type ZBAPIKEV v BAPL created by kel o e P
Change Release Status ->

Test/Execute

[—@ Interfaces Create

Object type component -> To i
modeled. (i o =

o

ZBAPT_KEV. ExistenceCheck 4 pocirentaiod

Program
ZBAPI_KEV.ZbapiT0OL L ET
ZBAPT_KEV.ZbapiVbak vy Persmaters )
ZBAPT_KEV.ZbapiTotal ~ BT Exceptions CutsshinsF8)
Object Type
Events
Edit >|  Choose &
Goto Test/Execute Fi
Utilities Create
< > I
Settings > | Redefine F
System > Repame
Help > Delete (shinsF

SAP GUI seftings and actions > Change Release Status > |  Object Type

Cancel F Object Type Component > To modeled

To implemented
To released

To obsolete

187, Goto More > Edit >

Change Release Status -> ] & 8 6 e A @@ e
Choose F2!

Ob]ect type Component > TO oObject type ZBAPIKEV v BAPI created by Ke )

TestExecute

implemented. |t azes Creats

Key fields

Redefine Fé
[—@ Attributes

Rename F
[—E Methods

Delete 4F

Existencecheck o Docincitition: (CHeSHITE
Displa [
oo Program 14E3)
ZBAPT_KEV.ZbapiT001 v
ZBAPT_KEV.ZbapiVhak . m 7 Parameters 4 F7
ZBAPI_KEV.ZbapiTotal © BT Exeptons esnifcsF
Object Type
Events
Edit >| Choose F2
Goto > | TesvExecute :
|
Utiities > | create Fs
< >
Seftings > Redefine Fe
System >|  Rename 7
Help > | Delete SriftiE2
SAP GUI settings and actions > | Change Release Status > |  Object Type

Cancel 12 Object Type Component > To modeled

To implemented
To released

Ta obsolete
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188.

Go to More -> Edit ->
Change Release Status ->
Object type component -> To
released.

RI4(1)400 A &

Change Object Type ZBAPI_KEV

- -
% @& B & Morev Q O @ Exit
. a3
) Choose F2 3
Object type ZBAPIKEV . BAPI created by ke
Test/Execute Fs
[—@ Interfaces Create FS)
Key fields Redefine o=
@ attributes
Rename F
—= Methods
Delete
tencecheck C  Documentation  (CutsShiftsFo)
PI_KEV.Display g
Program
ZBAPT_KEV.ZbapiT001 . ET
ZBAPI_KEV.Zbapivbak oymy|  Faeameters
ZBAPT_KEV.ZbapiTotal ~ BT Exceptions (CrtsShift4Fa
Object Type
Events
Edit >| Choose
Goto >|  TestExecute
Utilties >|  Create s
< > I
Settings > | Redefine e
System >|  Rename
Help > Delete ShiftsF2)

SAP GUI settings and actions > | Change Release Status > |  Object Type

Cancel 712 Object Type Component > | To modeled

To implemented
To released

To obsolete

189.

Click Generate.

Object type 'ZBAPI_KEV' generated successfully

< SAP Change Object Type ZBAPI_KEV

’ vi % = L - More v Q d G Exit

Object type ZBAPI_KEV v BAPI created by Kevin -
—0&@ Interfaces
Key fields
—0@ Attributes
—0&= Methods
ZBAPI_KEV.ExistenceCheck Check existence of object
ZBAPI_KEV.Display Display object
ZBAPI_KEV.Zbap‘iTOOl v B TEST
ZBAPI_KEV.ZbapiVvbak v B TEST
ZBAPI_KEV.ZbapiTotal v B TEST
Events

<>

Save Without Checking eI
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190. Go to transaction BAPI. BAPI Explorer
. . More ~ Q o E
191. Click on Alphabetical.
. . ¥ Details Documentation 3 Tools 2 Project
192.  Find your BAPI as shown in —
the screenshot. Method (BAPI)
Method: [zbapiTotal
Hierarchical Alphabetical
Business object
> B VendorEvents o
» B VendorSetilement Short description: [TEST
> £ VisitList
> E VisitPlan
> = waskl New in Release:
> ©J WFMResource
» E WarehouseStock
» = WarshousaTransOrder Function module: [ZBAPT_VBAK_TOTAL |
> B WarenbewegungDFPS
> & WarrantyClaim ALE message type: |Dues not exist |
» ©1 WasteContainer
> & Wiedervorlage
> E WorkBreakdownStruct Z>  Instance-indepndt [0 Dialog
> B WorkCenter
~ B ZBAPI_KEV
Status
> E ZbapiT0O1
\ I, ZbapiTotal Release status: |Released
{5l Vbtyp
=T Return
(& ltemtab
> Z, ZbapiVbak
> B ZBUS1072_1 I
> £ ZBUS2012

4.4 Create Virtual Procedure

In HDI container, we can create a virtual procedure mapping to the custom BAPI in SAP ERP. Currently, the creation of
virtual procedure still requires manual effort in SAP HANA Cloud. This SAP Help provides an example artifact code as
following:

VIRTUAL PROCEDURE "com.sap.hana.example::REMOTE PROCEDURE"

(
IN INT PARAM AS IN INT,

OUT OUT TABLE TABLE ( INT COLUMN INT, NVARCHAR COLUMN NVARCHAR (2000))

)
CONFIGURATION '{}'
AT REMOTE SOURCE

From the above code lines, there are 3 sections that needs to be replaced: parameters, configuration, and remote
source. These information can be found in the function metadata by executing the following procedure:

call GET REMOTE SOURCE FUNCTION DEFINITION ('REMOTE SOURCE NAME HERE',
'BAPI.BAPI NAME HERE', 2 , ?, ?)

In this documentation, the above SQL statement is executed as following:

call GET REMOTE SOURCE FUNCTION DEFINITION ('S4 RI4', 'BAPI.ZBAPI VBAK TOTAL', 2 , ?, ?)
In return, you can see 3 results and a message from the following screenshot. In Result 1, it show all the Parameters
that need in this virtual procedure; In Result 3, it shows lines of code needs to be added as Configuration.
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SQL Console 1.sgl x

@ . Analyze ~

1~ call GET_REMOTE_SOURCE_FUNCTION_DEFINITION('S4_RI4',

Result 1 x Result 2 x

Rows (17)
PARAMETER_NAME
VBTYP
RETURN_TYPE
RETURN_ID
RETURN_NUMBER
RETURN_MESSAGE
RETURN_LOG_NO

W o~ D! R W N e

I
WMo

RETURN_ROW

l Current schema: DBA.

Result 3 x

PARE
IN
ouT
ouT
ouTt
ouT
ouT

RETURN_LOG_MSG_I QUT
RETURN_MESSAGE_Vw OUT
RETURN_MESSAGE_V OUT
RETURN_MESSAGE_V OUT
RETURN_MESSAGE_Vv OUT
RETURN_PARAMETER QUT

ouTt

E DATA_TYPE_N 7} LENG]

NVARCHAR
NVARCHAR
NVARCHAR
NVARCHAR
NVARCHAR
NVARCHAR
NVARCHAR
NVARCHAR
NVARCHAR
NVARCHAR
NVARCHAR
NVARCHAR
INTEGER

Messages x

History

1
1
20

3

220
20
6
50
50
50
50
32
0

SCALE

o olo o oo oloo oo olo

[ R R T R

i ==
Wi RO

saL | ¥ @
PARAMETER_POSITION

k)

Therefore, the virtual procedure code can be constructed by the above information as followings:

VIRTUAL PROCEDURE "calculationview.db::RI4_ZBAPI_VBAK_TOTAL"(
IN VBTYP NVARCHAR(1),

}

ouT
ouT
ouT
ouT
ouT
ouT
ouT
ouT
ouT
ouT
ouT
ouT
ouT
ouT

TYPE NVARCHAR(1),

ID NVARCHAR(20),

NUMBER NVARCHAR(3),
MESSAGE NVARCHAR(220),
LOG_NO NVARCHAR(20),
LOG_MSG_NO NVARCHAR(6),
MESSAGE_V1 NVARCHAR(50),
MESSAGE_V2 NVARCHAR(50),
MESSAGE_V3 NVARCHAR(50),
MESSAGE_V4 NVARCHAR(50),
PARAMETER NVARCHAR(32),
ROW1 INTEGER,

FIELD NVARCHAR(30),
SYSTEM NVARCHAR(10),

IN ITEMTAB_IN TABLE (VBTYP NVARCHAR(1),ERNAM NVARCHAR(12),NETWR DECIMAL(16, 2)),
OUT ITEMTAB_OUT TABLE (VBTYP NVARCHAR(1),ERNAM NVARCHAR(12),NETWR DECIMAL(16, 2)))
CONFIGURATION '{

"__DP_UNIQUE_NAME__":

" DP_HAS_NESTED_PARAMETERS__":

" _DP_VIRTUAL_PROCEDURE_ ":
" DP_HAS_INTERNAL_OUTPUT PARMETER__":

AT "S4_RI4"

We will use the above code to create a virtual procedure in SAP Business Application Studio.

"ZBAPI_VBAK_TOTAL",
false,
" DP_USER_DEFINED PROPERTIES_ ":
" __DP_INPUT_PARAMETER_PROPERTIES ": [
" _DP_RETURN_PARAMETER_PROPERTIES_":
true,

i}

1,
L1,

false,
" _DP_DEFAULT_OUTPUT_PARAMETER_INDEX__":
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Explanation

Screenshot

193. Goto SAP HANA Cockpit
-> Privilege Assighment

194.  Add the privilege CREATE
VIRTUAL PROCEDURE and
CREATE VIRTUAL TBALE ON
remote source S4_RI4 for
ANALYTICSADMIN

| ANALYTICSADMIN x Q|

SYSTEM PRIVILEGES (4) OBJECT PRIVILEGES (4) ANALYTIC PRIVILEGES (0)

Object Name Object Schema Grantor Object Types
ANALYTICSADMIN SYS SCHEMA

S4_RI4 DBADMIN REMQTE SOURCE
SQLServerl? DBADMIN REMOTE SOURCE

PRIVILEGES ON USERS (0)

Search

Privilege

CREATE ANY

CREATE VIRTUAL
PROCEDURE

CREATE VIRTUAL
TABLE

CREATE VIRTUAL
TABLE

Q|

Grantable to
Others

Yes

Yes
Yes

No

195. Navigate to SAP Business
Application Studio

196. Open Analytics.hdbgrants

197. Grant the container’s object
owner the privilege CREATE
VIRTUAL PROCEDURE ON
REMOTE SOURCE on the
remote source.

Note: Don't forget to include the
comma at the beginning!

Analytics.hdbgrants %

1

2 "AnalyticsUPs™: {

3 "object_owner”: {

4 "schema_privileges":[

5 {

6 "reference” :"ANALYTICSADMIN",

7 "privileges_with_grant_option™:["SELECT","EXECUTE"]
8 }

9 1]

1@ "global_object_privileges™ : [

11 {

12 "name” : "S4_RI4",

13 "type"™ : "REMOTE SOURCE",

14 "privileges” : [ "CREATE VIRTUAL TABLE" ],
15 "privileges_with_grant_option” : [ "CREATE VIRTUAL PROCEDURE"
16 1

7 ]

18 i

19 "application_user”: {

28 "schema_privileges":[

21 {

22 "reference” :"ANALYTICSADMIN®,

23 "privileges_with_grant_option™:["SELECT"]

24 1

25 1

26 1

27 ]

28

198. Deploy the new
Abalytics.hdbgrants

“ SAP HANA PROJECTS
~ I

~ [l Src (pending deployment

CalculationViews/db (pending deployment

i Analytics hdbgrants (pending deployment)

@

B AnalyticsUPS hdbsynonym
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199.  Goto View ->Find 23 File Edit Selection View Go Run Terminal Help
Command... =
@ EXPLORER Find Command... Ctrl+Shift+P
» CALCULATIONVIEWS Open View...
v mdb Call Hierarchy Ctri+Shift+F 1
> W node_modules Debug Cir+Shift+D
Qg@ T Debug Console Ctrl+Shift+Y
% _hdiconfi
contg Explorer Ctrl+Shift+E
& env
@ » Extensions Ctrl+Shift+X
€ _gitignore
. . Outline Ctrl+Shift+

200. Search for Create SAP
HANA Database Artifact =create sap hana datahasel

201.  Clickon it SAP HANA: Create SAP HANA Database Artifact

202.  Select Virtual Procedure .

as Artifact Type Create SAP HANA Database Artifact
203.  Enter Artifact name Choose the artifact that you need for your project
204.  Click Create

Specify where you want to create the new artifact.

/home/user/projects/CalculationVie [

Choose the database version. (2) *

HANA Cloud v

Choose the artifact type. (2) *

Virtual Procedure (hdbvirtualprocec v

Specify the artifact name. @ '

Rl4_ZBAPI_VBAK_TOTAL

205.  Open the created Virtual VIRTUAL PROCEDURE "calculationview.db::RI4_ZBAPI_VBAK_TOTAL"(
IN VBTYP NVARCHAR(1),
Procedgre apd (?opy the code OUT TYPE NVARCHAR(1).
on.the right side into the code OUT ID NVARCHAR(20),
editor OUT NUMBER NVARCHAR(3),

OUT MESSAGE NVARCHAR(220),
OUT LOG_NO NVARCHAR(20),

OUT LOG_MSG_NO NVARCHAR(6),
OUT MESSAGE_V1 NVARCHAR(50),
OUT MESSAGE_V2 NVARCHAR(50),
OUT MESSAGE_V3 NVARCHAR(50),
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OUT MESSAGE_V4 NVARCHAR(50),

OUT PARAMETER NVARCHAR(32),

OUT ROW1 INTEGER,

OUT FIELD NVARCHAR(30),

OUT SYSTEM NVARCHAR(10),

IN ITEMTAB_IN TABLE (VBTYP NVARCHAR(1),ERNAM NVARCHAR(12),NETW
R DECIMAL(16, 2)),

OUT ITEMTAB_OUT TABLE (VBTYP NVARCHAR(1),ERNAM NVARCHAR(12),NE
TWR DECIMAL(16, 2)))
CONFIGURATION '{

" _DP_UNIQUE_NAME__ ": "ZBAPI_VBAK_TOTAL",
"__DP_HAS_NESTED_PARAMETERS__ ": false,
" _DP_USER_DEFINED_PROPERTIES_ ": {},

" DP_INPUT_PARAMETER_PROPERTIES ": [],

" DP_RETURN_PARAMETER_PROPERTIES ": [],

" DP_VIRTUAL_PROCEDURE_ ": true,

" DP_HAS_INTERNAL_OUTPUT PARMETER__": false,
" DP_DEFAULT OUTPUT_PARAMETER_INDEX_": @

AT "S4_RI4"

206.  Deploy the virtual “ SAP HAMA PROJECTS
procedure v [ CalculationViews/db (pending deployment
~ [l Src (pending deployment
I Analytics hdbgrants
B AnalyticsUPS. hdbsynonym
E R4 7BAPI VBAK TOTAL hdbvirtualpr.. |

ey

4.5 Create HANA Function

In SAP HANA Cloud, we currently have to use HANA Function to make the use of the virtual procedures. Thus, the next
step is to create a HANA function to call the virtual procedure in HDI container. In the definition of the virtual procedure,
a HANA table is required as an input parameter, so we will start from creating a HANA table in HDI container.

Explanation Screenshot

207. Search for Create SAP
HANA Database Artifact =create sap hana -::iatal:asei

208 Clickon it SAP HANA: Create SAP HANA Database Artifact
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209. Select Table as Artifact
Type

210. Enter Artifact name

211. Click Create

Create SAP HANA Database Artifact

Specify where you want to create the new artifact.
/home/user/projects/CalculationVie [

Choose the database version. @ -

HANA Cloud W

Choose the artifact type. (3) *

Table (hdbtable) v

Specify the artifact name. @ '

ITEMTAB_IN

212.  Open the created Table
and copy the code on the right
side into the code editor

COLUMN TABLE "calculationview.db::ITEMTAB_IN" (
"VBTYP" NVARCHAR(1),
"ERNAM" NVARCHAR(12),
"NETWR" DECIMAL(16,2)

213. Deploy the
ITEMTABL_IN.hdbtable

~ SAP HANA PROJECTS
~ @ CalculationViews/db (pending deployment)
~ [ SIc (pending deployment)
B Analytics hdbgrants
B AnalyticsUPS hdbsynonym
i 'TEMTAB_IM hdbtable (pending deplwmenlE

E R4 ZBAPI VBAK TOTAL hdbvirtualproce...

214. Search for Create SAP
HANA Database Artifact
215. Click on it

>create sap hana databasd

SAP HAMA: Create SAP HANA Database Artifact
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216.  Select Function as Artifact .
Type Create SAP HANA Database Artifact
217.  Enter Artifact name
218.  Click Create
Specify where you want to create the new artifact.
@ =
/home/user/projects/CalculationVie 0O
Choose the database version. @ ”
HANA Cloud v
Choose the artifact type. (3) *
Function (hdbfunction) v
SWCWH@aﬂhtrmm.C)'
ZBAPI_VBAK_TOTA
219. Open the created Funtion FUNCTION "ZBAPI_VBAK_TOTAL"( )

and copy the code on the right

side into the code editor

RETURNS TABLE (
"VBTYP" NVARCHAR(1),
"ERNAM" NVARCHAR(12),
"NETWR" DECIMAL(16,2))
LANGUAGE SQLSCRIPT
SQL SECURITY INVOKER AS
BEGIN

/*****************************

Write your function logic
stk stk ok ok skok sk ok ok skok skok ok ook skokskok /

DECLARE il NVARCHAR(1) :='C';

DECLARE
DECLARE
DECLARE
DECLARE
DECLARE
DECLARE
DECLARE
DECLARE
DECLARE
DECLARE
DECLARE

ol
02
03
o4
o5
06
o7
08
09

010 NVARCHAR
011l NVARCHAR

NVARCHAR
NVARCHAR
NVARCHAR
NVARCHAR
NVARCHAR
NVARCHAR
NVARCHAR
NVARCHAR
NVARCHAR

(1);
(20);
(3);
(220);
(20);
(6);
(50);
(50);
(50);
(50);
(32);

DECLARE 012 INTEGER;
DECLARE 013 NVARCHAR (30);
DECLARE 014 NVARCHAR (10);

ITEMTAB_IN = select * from "calculationview.db::ITEMTAB_IN";

call "calculationview.db::RI4_ZBAPI_VBAK_TOTAL"(il,01, o2, o3,
o4, o5, o6, o7, o8, 09,010,011,012,013,014, :ITEMTAB_IN,ITEMTAB_ O
uT);

RETURN
SELECT * FROM :ITEMTAB_OUT;
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END;

220. Deploy the

ZBAPI_VBAK_ TOTAL.hdbfunct
ion

~ SAP HANA PROJECTS
~ @ CalculationViews/db (pending deployment
~ [ Src (pending deployment

Bl Analytics hdbgrants

B AnalyticsUPS hdbsynonym

i ITEMTAB IM hdbtable (pending deployment
E R4 ZBAPI VBAK TOTAL hdbvirtualproce...
b
]

Sales hdbcalculationview (pending deployment

ZBAPI_VBAK_TOTAL hdbfunction (pen.. |

4.6 Create Calculation View

Finally, we can create a calculation view using the above function in HDI container.

Explanation

Screenshot

221. Search for Create SAP
HANA Database Artifact
222. Click on it

>create sap hana databasd

SAP HAMNA: Create SAP HANA Database Artifact
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223. Select Calculation View as

Artifact Type

224,

Enter Artifact name

225. Click Create

Create SAP HANA Database Artifact

Specify where you want to create the new artifact.
@ =

/home/user/projects/CalculationVie 0
Choose the database version. (3) *

HANA Cloud v
Choose the artifact type. @ -

Calculation View (hdbcalculationvie v
Specify the artifact name. @ :

ZBAPI_VBAK_TOTAL

Specify the label. (2

226.
227.

Click Aggregation
Click Add Data Source

ZBAPI_VBAK TOTAL hdbcalculationview x ZBAP

e H E s » 4
»
an
w»
8
e . Semantics
=
B ijﬁ"" Aggrégation V%z +
g O O O
El
R
=
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228. Search Function
ZBAPI_VBAK_TOTAL

Find Data Sources

229.  Select the Function Sesrch foran objectname
230 CIICk FI nISh Services 1 Services Selected ~
All Types Selected ~ ||| zbapi ® |
Results (1)
Type Name Schema Synonym
R calculationview.db::ZBAPI_VB.. CALCULATIONVIE...
P
231. Create Mapping as shown | Aggregation <
in the ”ght screenshot Mapping Calculated Columns (0) Restricted Columns (0) Parameters (0 e
7 ~ » -
Data Sources Q Qutput Columns Q
v Rcalculationview.db:ZBAPI_VBAK —e ¢ VBTYP
i NETWR ,__/_, # ERNAM
i ERNAM — Drag & drop here

232.  Deploy
ZBAPI_VBAK_TOTAL.hdbcal
culationview

~ SAP HANA PROJECTS
~ @ CalculationViews/db (pending deployment)
~ [ SIc (pending deployment)
B Analytics hdbgrants
B AnalyticsUPS hdbsynonym
I |TEMTAE_IN hdbtable (pending deployment)
E R4 ZBAPI VBAK TOTAL hdbvirtualproce...
B Sales hdbcalculationview (pending deployment)
]
]

ZBAPI_VBAK_TOTAL hdbcalculationvi... |
ZBAPI_VBAK_TOTAL hdbfunction (pending ...
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233.  Congratulations! You have
created a calculation view in
SAP HANA Cloud

SAP SAP HANA Database Explorer

)
+
9,
Q

Filter Databases

+ [ CalculationViews-hdidb-ws-2fxz5 (PROD)
fH Column Views
(& Cubes
8 Functions
=# Graph Workspaces

Search ColumnViews Q W

Sales

wh

i

Sales/RegionLBH/ier/RegionLBH

wh

ZBAPI_VBAK_TOTAL

4.7 Create a story in SAP Analytics Cloud

Explanation

Screenshot

234. Logon to your SAP
Analytics Cloud tenant.

235. Click on the Main Menu.

Today  Catalog Fav

Hello,
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236. Select Modeler X SAP Analytics Cloud

Stories

Analytic Applications

Digital Boardroom

Datasets

Modeler

Data Actions

237. Click on Live Data Model
Welcome to the Modeler

Prepare your raw data using a structured view and get started with your scenario analysis. Learn More.

Models Public Dimensions Currency Conversions Paints of Interest

Create New

Mode! From a CSV or Excel File Live Data Model

From a Data Source
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238.  Enter the following
information
System Type: SAP HANA
Connection: HANACIoud
Data Source:
ZBAPI_VBAK TOTAL

239.  Click OK.

Create Model From Live Data Connection

Select Live Data Connection and Data Source
*System Type:
SAP HAMNA ~

*Connection:

HANACloud ~

*Data Source:

ZBAPI_VBAK_TOTAL my

OK Cancel

240. Save the model.

70103 Files / New Model

_ ) O )
@ Data sources ELN Bl & ©® AL
ID Description Agpregation Ty...
1 | NETWR NETWR SUM
2
241.  Provide the new Model a Save Model
name and save it in a directory.
My Files / Public / It | ABAP (] All files ~ | Search Q
Name =  Description Owner
% ABAPTABLES - Kevin Li
%; BAPI_COMPANY_LIST = Kevin Li
%, BAPI_SALESORDER_GET.. - Kevin Li
% IBAPI_VBAK = Kevin Li
% ZBAPI_VBAK_TOTAL - Kevin Li
*Name

ZBAPI_VBAK_TOTAL

Description

OKY Cancel
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242.  Select Stories X 5P Anapics Coud < SAP W s
243.  Select Responsive & Home
Welcome to Stories
= E= Create a story to visualize, summarize, explore, and monitor your data. Add charts, tables, text, and other objects, and share you
Apps
Create New
[ Stories
¥ Analytic Applications
71 Digital Boardroom Responsive Canvas Grid From a Smart Discovery
B Datasets Templates
@ medeler [ (N I = R S
5. Data Actions
Analytic Template V1 New Documen(3) Templ... table template Analytic Template V2
244. Remove one of the + Add lane
responsive pages. @ Copy
& Edit Styling...

i Remove

245. Insert a Chart. @ 70103 Files / New Document* +r

~ File Insert
So e av @y a- [=] & = +-
246 Se|eCt the mOdel Select Dataset or Model
ZBAPI_VBAK_TOTAL.
My Files / Public/ It 1 ABAP All files ~ | Search Q
Name =  Description Owner
.'?5 ABAPTABLES - Kevin Li
%, BAPI_COMPANY_LIST = Kevin Li
%, BAPI_SALESORDER_GET.. - Kevin Li
% IBAPI_VBAK = Kevin Li
% ZBAPI_VBAK_TOTAL - Kevin Li
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247. Select NETWR as S .
ata Source rsy
Measures. ZBAPI_VBAK_TOTAL s
248. Select ERNAM as _
Dimensions =+ Add Linked Models
v Chart Structure +
Comparison Trend Distribution
= = b
Correlation Indicator More
I:'_.. M @\ 0\
Chart Orientation
Vertical ~
Measures
i NETWR ®
+ Add Measure
Dimensions
i ERNAM ®
-+ Add Dimension
249.  The chart look should like AL e g ot
the screenshot.
250. Save the story.
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5. Current Limitations

This chapter covers the current limitations of SAP Analytics Cloud using SAP HANA Cloud as a single gateway to
heterogenous remote sources.

5.1 Building Calculation Views in SAP HANA Cloud

Compare to the existing live data connectivity in SAC, HANA data modeling is an extra effort that must be invested by
modelers. In order to have live analytics on the remote source, you must know how to build calculation views in SAP
HANA Cloud using the virtual tables or virtual procedures.

5.2 Geospatial is not Supported

SAP HANA Spatial allows you to store and geo-process spatial data using various data types, algorithms, and
constructors. However, Geospatial is not currently supported for Live Data Connections to SAP HANA HDI containers
on SAPCP on Cloud Foundry (CF) systems.

5.3 Creating Custom BAPIs in SAP NetWeaver AS ABAP

Custom BAPIs need to be developed in most use cases. The performance best practice requires BAPIs to return
aggregated results for optimal performance, however, very few existing BAPIs return aggregated results. Creating
custom BAPIs requires some ABAP programming knowledge and effort. Whereas in general, it is not difficult to create
custom BAPIs returning the aggregated results.

5.4 Known Limitations for Neo Environment

For SAP Analytics Cloud tenant provisioned in Neo environment, The following SAP Analytics Cloud features are not
supported with Live Data Connection to HANA Cloud using a Direct Connection at this time:

Enriched time dimensions

Timestamp dimensions

Dynamic image widgets

Smart Insights

Smart Assist/Changes Over Time in Smart Insights
Smart Predict

Story scheduling

Android/iOS Mobile App:

SAP Cloud Connector-based single sign-on

Basic Authentication connections

Geo maps

OEM scenarios through “Extended Live Connections”
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